USC Psychology 314L (52524)
Experimental Research Methods

Dornsife Fall 2020
Dana and David Dornsife

College of Letters, Arts

B e Lecture Location: Zoom (Links Located on Blackboard)

Department of Psycholo
E i Days and Time: Tuesday & Thursday; 8:00 a.m. to 9:20 a.m.

Lab Location: Zoom (Links Located on Blackboard)
Lab Day and Times: Wednesday, 10:00 a.m. to 11:50 a.m.; Thursday, 2:00 p.m. to 3:50 p.m.
Online portion at http://blackboard.usc.edu

Instructor Information

Dr. Clayton L. Stephenson Office Location: Home ©
Assistant Professor (Teaching) Psychology  Office Hours: By Appointment; Email to Schedule
clstephe@usc.edu I’m more than happy to meet with you one-on-one!

TA Information
Jackson Trager
jptrager@usc.edu

Syllabus

Course Description
Experimental research methods in psychology; nature and concepts of scientific method. Lab
exercises, data analysis and preparation of APA style empirical report.

My Course Summary

Psychology is a science. Science requires specific methods that tests, supports, or disconfirms
hypotheses that lend supporting evidence or no evidence to a theory. Therefore, the course you
are about to take is one of the most important courses you will take in psychology. Without
rigorous, systematic research methods, much of the theoretical and practical knowledge we have
about perception, cognition, attitudes, learning, human development, stereotypes, and many other
areas in psychology would not exist. Although this course is not content specific, the knowledge
and content of the course can be applied to any content specific course in psychology and
neuroscience. You will learn about the philosophy of science, the various types of methods
psychologists use, how to conduct an experiment, and write a research paper adhering to the
Publication Manual of the American Psychological Association.

Prerequisites
PSYC 100 (Introduction to Psychology)

Teaching Objectives
1) Provide students with the fundamental knowledge of experimental research methods and
design used in psychology.
2) Facilitate students understanding for how using valid scientific methods can improve and
create knowledge in the field of psychology.
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3) Guide and mentor students in developing, completing, writing, and presenting a valid and
ethical psychology experiment.

Student L earning Objectives
After successfully completing this course, students will be able to . . .
1) identify areas in psychology in which they have strong interests.
2) describe and discuss the concepts in various psychological research methods and design.
3) critically analyze scientific claims made in popular and academic media.
4) analyze and interpret quantitative data.
5) collaborate and complete psychological research projects with their peers.
6) verbally present their research findings in a coherent and concise manner.

Required Texts

American Psychological Association. (2020). Publication manual of the American
psychological association (7" ed.). Washington, DC: American Psychological
Association.

Goodwin, K.A. & Goodwin, C.J. (2017). Research in psychology: Methods and design (8"
ed.). John Wiley & Sons, Inc.

Beins, B. C. & Beins, A. M. (2012). Effective writing in psychology: Papers, posters, and
presentations (2" ed.). John Wiley & Sons, Inc.

NOTE: Goodwin & Goodwin textbook is abbreviated as (GOOD) in the schedule. Biens &
Beins textbook is abbreviated as (BEINS). The Publication Manual is abbreviated as (APA).

Supplemental Readings. (Various dates). Posted on Blackboard.
NOTE: Texts are available at the bookstore or online.

Assessment Focused Due Date Percent of Final Grade:
Learning Points
Obijective(s)
Research Proposal 1,2,3,5,6 October 2" by | 20 (individual grade): 100
11:59 p.m.
Final Research Paper 1,2,3,4,5, | November 17" by | 25 (individual grade): 100
6 11:59 p.m.
Research Project 4,5,6 November 17", | 20 (individual grade): 100
Presentation 8:00 a.m. to 10:00
a.m.
Lab Assignments 1,2,3,4,5, Continuous 25 (individual or group): 10
6 points each
Participation 2,3,5,6 Continuous 10 (individual or group): 10
points each

Research Proposal & Final Research Paper
You will write a research proposal throughout the first half of the semester and collect data in

accordance to your proposal during the second half of the semester. The research proposal is an
important process in providing a clear statement of the problem, an argument for the purpose of
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your study using appropriate sources, how previous studies relate to your study, formal research
questions and hypotheses, a full methods section, and a data analysis plan. The final research
paper will be the result of your semester’s lab work and a demonstration of your ability to apply
your knowledge so that you have a real experimental study to report. You will work in groups of
three or four to in completing the project, but you will write the proposal and final paper
individually. Please Note: These two papers are 45% of your grade, so be diligent in writing
your paper and getting help from your lab instructor or me immediately if you have any
problems.

Research Project Presentation
In place of a final exam, you will present your research project with your group. Presentations

are presented in a conference format and must be professional. You may be as creative as you
want to be in presenting your study and PowerPoint is NOT required. A rubric on how you are
graded is posted on Blackboard. You are also required to listen to everyone’s presentation and
you will be docked one letter grade on your project presentation grade for leaving early. Please
Note: The presentation is 20% of your grade, so you will be held to high expectation and
standards.

Weekly Lab Assignments

The lab assignments are designed for you to acquire the necessary skills, knowledge, and tools to
complete your research proposal and final research paper. Labs are also designed for you to
acquire, at the minimum, a working knowledge of the process involved in completing an
experiment from start to finish. Some lab assignments require each person to turn in an
assignment while others require one person to turn in an assignment for the group. You will
receive detailed instructions for completing each lab assignment; read them carefully because it
is your responsibility to turn in the assignments as instructed! You will also learn or relearn
statistical software, how to read output, and how to use APA format in your papers. Lab
assignments are due five days after the lab day at 11:59 p.m. More specifically, Wednesday’s
labs are due Mondays by 11:59 p.m. and Thursday’s labs are due Tuesdays by 11:59 p.m.

Participation in Lecture

Reading the assigned material and completing the assignments before class and lab are important
to understanding the lecture topics and to participating in the discussions. Participation will be
assessed through in-class exercises, activities, and discussion. Exercises may occasionally be
assigned in class in order to help you to understand the course material. Some exercises will be
worked on in class while others may be worked on in class and at home. Participation will be
graded based on the completion and quality. Your lowest THREE participation grades will
be dropped.

EXTRA CREDIT: Participate in Research Studies and Worksheets

Part of understanding the research process is being a participant in a study. You may participate
in research studies conducted in the psychology department to earn 6 extra credit points. All
points will be applied to your Final Research Paper. However, you cannot earn more than 100
points on your Final Research Paper, and any leftover extra credit points will not be applied to
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any other assignments. You can view and sign up for studies through the SONA system at
https://usc.sona-systems.com/. Please note that your participation in research is voluntary and
you have the right to NOT participate in research studies. If you do not want to participate in
studies, then you may complete the alternative, which is writing three two-page papers on three
separate topics, which are also posted on Blackboard. All credits and/or papers are due by
11:59 p.m. on November 13", No exceptions!

Grading Scheme
Please Note: 1 do NOT curve the grade. Whatever grade you have on Blackboard is your grade in

real-time that you earned to that date. 1 do round up (e.g., 93.45 = 93.5%) for your final grade.
Finally, it is NOT appropriate for you to ask to make up an assignment at the end of the semester that
was due past what is outlined in the late policy (see pp. 10 — 11) or to ask for extra credit beyond what
is described above, so please do NOT ask for either.

A =100 - 93.5%; A-=93.4 - 89.5%; B+ =89.4 - 86.5%; B = 86.4 - 83.5%; B- =83.4 - 79.5%;
C+=79.4-76.5%; C=76.4-73.5%; C-=73.4 - 69.5%; D+ =69.4 - 66.5%; D = 66.4 -
63.5%; D- = 63.4 - 59.5%; Below 59.5% = F

Statistics Background

All students in this class are required to have achieved a C- grade or better in their Statistics (PSYC
274) course. Students should have an introductory level of familiarity with descriptive and inferential
statistics, their interpretation, and writing of statistical results. Experimental Research Methods builds
heavily upon your background in statistics; students without an adequate background in statistics may
find this course difficult. We will thoroughly review common statistical methods. You should be able
to identify the appropriate statistics for each design type, depending on the scale of measurement used
by the researchers. You will be expected to be able to input data into SPSS, run the appropriate
statistics, read SPSS output, be able to infer the number of participants in the sample and levels of an
independent variable from degrees of freedom. All of these skills will be taught or reviewed in lecture
and labs.

Instructor Student Communication and Blackboard

Blackboard (Bb) will be used to post announcements, send e-mails, and post all grades and
course materials, so it is the student’s responsibility to frequently visit the course on
Blackboard (website: http://blackboard.usc.edu). Bb transactions will follow the below
guidelines.

1) Grades: All grades and points will be posted on Bb one to two weeks after the
completion of the exam, assignment, or activity. Grades will not be announced in class,
via e-mail, or during office hours.

2) Course Materials: The syllabus, lab assignments, and supplemental reading material
can be viewed and printed from Bb.

3) Announcements: Class announcements will be posted on Bb, as well as broadcasted in
class.

4) Email: Any email communications from the instructor or TA will be sent via Bb or
through the USC’s email service. USC requires that all e-mail communication between
the instructor and students be sent via an official USC e-mail address. Any student
communication delivered from a non-USC e-mail address will be automatically
discarded.
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Tentative Schedule of Topics and Assignments

Topic Reading Deliverables
WEEK 1
Tuesday Overview of Syllabus N/A
08/18/2020 Course
Thursday Purpose of the None In-class exercise
08/20/2020 Course Discussion
Psychological
Science as a
Career
WEEK 2
Tuesday Scientific Chapter 1 In-class project
08/25/2020 Thinking (GOOD) (cont.)
Presentations
Thursday Understanding Evans & In-class exercise
08/27/2020 Published Rooney
Research (2016); on Bb
WEEK 3
Tuesday Developing Ideas Chapter 3 In-class exercise
09/01/2020 The Importance (GOOD) pp.
of Writing 60 - 69
Plagiarism Kline (2009);
on Bb
Thursday Understanding Chapter 3 In-class exercise
09/03/2020 Theories (GOOD) pp. and discussion
The Locke 12- 70 - 88
Step Stephenson
& Halpern
(2011); on Bb
WEEK 4
Tuesday Essentials of Chapter 5 In-class exercise
09/08/2020 Experimental (GOOD)
Research in
Psychology
Internal &
External Validity
Thursday Between- Chapter 6 In-class activity
09/10/2020 Subjects Design (GOOD) pp.
159 - 166;
177 - 185
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WEEK 5

Tuesday » Within-Subjects Chapter 6 In-class exercise
09/15/2020 Design (GOOD) pp. and group
167 - 177 activity
Thursday » Single Factor Chapter 7 In-class exercise
09/17/2020 Designs with (GOOD) pp.
Two Levels 189 - 197
WEEK 6
Tuesday » Single Factor Chapter 7 In-class exercise
09/22/2020 Designs with 3 (GOOD) pp.
or More Levels 198 — 203;
» Control Groups 209 -215
Thursday » Factorial Designs Chapter 8 In-class activity
09/24/2020 (Basic) (GOOD) pp.
219 - 237
WEEK 7
Tuesday » Factorial Designs Chapter 8 In-class exercise
09/29/2020 (Varieties) (GOOD) pp.
237 - 251
Thursday » Writing Using Chapter 2 Bring a Full
10/01/2020 Scholarly Style (GOOD) pp. Draft of Your
» Avoiding 30 - 47 Research
Plagiarism Ethics Proposal
documents; Proposal Due
on Bb 10/02/20
WEEK 8
Tuesday » Sampling from Chapter 4 In-class exercise
10/06/2020 Populations (GOOD) pp.
» Power Analysis 93 -101
Denis (2003)
pp- 13 -17;
on Bb
Thursday » Validity Chapter 4 In-class activity
10/08/2020 » Reliability (GOOD) pp.
» Measurement 101 -109
Scales
WEEK 9
Tuesday » Ethics in Ethics In-class
10/13/2020 Psychological documents; discussion
Science on Bb
Thursday » Institutional Readings on In-class activity
10/15/2020 Review Board Bb

(IRB)
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WEEK 10

Tuesday Interpreting Readings on Lecture-
10/20/2020 Main Effects Bb discussion
Thursday Interpreting McBride In-class activity
10/19/2020 Main Effects and (2013); on Bb
Interactions Privitera
(2014); on Bb
WEEK 11
Tuesday Introductory Chapter 4 In-class exercise
10/27/2020 Review of (GOOD) pp.
Statistics 110 -128
Thursday False Positive Simmons et In-class exercise
10/29/2020 Psychology al. (2011); on
Power & Value of Bb
Replication in W Roediger
Science (2012); on Bb
WEEK 12
Tuesday Alternatives to Denis (2003); In-class exercise
11/03/2020 NHST on Bb
Significance, Fidler &
Effect Size, & Cumming
Confidence (2013); on Bb
Thursday Reporting Chapter 9 In-class exercise
11/05/2020 Results (BEINS)
Using Tables and
Figures to
Display Results
WEEK 13
Tuesday Abstracts Chapter 15 In-class exercise
11/10/2020 Fine Tuning Your (BEINS)
Writing
Thursday Giving Oral Chapter 17 In-class activity
11/12/2020 Presentations (BEINS)
Kline (2009);
on Bb
WEEK 14
Tuesday Research Presentations: 8:00 a.m. to 10:00 a.m.
11/17/2020 Final Research Paper Due TODAY at 11:59 p.m.
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Tentative Schedule of Labs

Topic Reading Lab Assignments:
Due by 11:59 p.m.
Five Days after Lab
WEEK 1
LAB #1 » APA Format » Chapters 1 » Title Page
» Microsoft Word & 2 » SPSS Data File
» SPSS (BEINS) » Summary of
Interviews
WEEK 2
Lab #2 » Evaluate Posted Article » Chapter 5 » Complete
» Create Groups (BEINS) Evaluation of
Article
WEEK 3
Lab #3 » Finalize Groups » Chapters » Complete
» Brainstorm Ideas for 2,3&4 Evaluation of
Final Research Paper (BEINS) Article
» Conduct Literature
Search for Final
Research Paper
WEEK 4
Lab #4 » Qualtrics » Chapters 9 » Prospectus for
» Finalize Topic for Final & 14 Final Project
Research Paper (BEINS) » Reference
» Reference Sections Section
WEEK 5
Lab #5 » Qualtrics (Advanced » Booth et » Introduction
Features) al. (2008) Section
» Research Questions & » Chapters 6
Hypotheses & 10
(BEINS)
WEEK 6
Lab #6 » Design Experiment » Chapter » Methods Section
» Determine Sampling 11 (BEINS)
Procedures
WEEK 7
Lab #7 » Ethics Certification » Chapter 7 » Ethics
> Work on Proposal (BEINS) Certifications
>
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WEEK 8

Lab #8 » Create Informed USC IRB Informed
Consent Handbook Consent Form
» Create Debriefing Debriefing
Statement Statement
WEEK 9
Lab #9 » Create Materials Review Statement about
» Confounds Chapter 4 Potential
> Finalize Design (GOOD) Confounds
» Collect Data? pp- 111 - Affecting
126 Internal &
External
Validity
WEEK 10
Lab #10 » Collect Data Chapter 8 SPSS File
» Create SPSS File (BEINS)
WEEK 11
Lab #11 » Collect Data Chapter SPSS File with
» Enter Data 12 (BEINS) Some Data
» Begin Analysis if Data Entered
Collection Completed
WEEK 12
Lab #12 » Collect Data! Chapters SPSS File with
» Analyze Data 12 & 13 Majority of Data
(BEINS) Entered
WEEK 13
Lab #13 » Abstracts Chapter Abstract
> Analyze Data 15 (BEINS) SPSS File
» Work on Final Paper Completed
SPSS Output

Zoom Sessions

We are Trojans. We will uphold the academic rigor, open discussion, and have fun regardless
of being online. My expertise is in principles of learning in the classroom and online learning.
I will not let being online deprive you of a top notch learning experience. | ask you, my fellow

Trojans, to do the following during our Zoom Sessions:

1) Attend as many lives sessions as possible. | promise, you will get more out of it.

2) If you cannot attend a live session, you will have the opportunity to watch the lecture
and complete the participation.

3) Leave your webcam on whenever possible to help create a sense of community and to
help socially connect. We are physically distanced, not socially distanced. Nonverbal
communication is still important!
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4) Please mute your mic when you are not speaking. | will mute you if | have to, but |
want you to take on the responsibility.

5) Ask questions! You may use chat, use the “raise hand” function, or even say, “Excuse
me. | have a question.” | promise you, | will not get upset if you verbally interrupt me
in a polite way. ©

6) For chat, please private message me for personal matters. If you have a question about
content, feel free to share with everyone. Having great questions in chat or verbally
make this fun! Seriously, | speak from experience.

Statement on Academic Integrity

USC seeks to maintain an optimal learning environment. General principles of academic honesty
include the concept of respect for the intellectual property of others, the expectation that
individual work will be submitted unless otherwise allowed by an instructor, and the obligations
both to protect one’s own academic work from misuse by others as well as to avoid using
another’s work as one’s own. All students are expected to understand and abide by these
principles. SCampus, the Student Guidebook, (www.usc.edu/scampus or http://scampus.usc.edu)
contains the University Student Conduct Code (see University Governance, Section 11.00),
while the recommended sanctions are located in Appendix A.

Statement on Plagiarism

Plagiarism, lazy writing, and cheating are violations of the Student Judicial Affairs &
Community Standards and may be dealt with by both the instructor and the university.
Plagiarism is defined as, “the act of presenting the ideas and writings of another as one’s own.”
Lazy writing is defined as, “using quotes or paragraphs with the proper citation, but are used in a
manner that a paper is stitched together and clearly has little or no original writing.” Cheating is
defined as, “the act of obtaining or attempting to obtain credit for academic work through the use
of any dishonest, deceptive, or fraudulent means.” In instances of academic dishonesty, the
instructor will take appropriate action as outlined in the Academic Integrity Review Process
(SJACS 14.10). For more information on avoiding plagiarism or lazy writing, see Chapter 1,
Section 1.10 in the APA Publication Manual or visit http://www.usc.edu/student-affairs/student-
conduct/ug_plag.htm.

Statement for Students with Disabilities

Any student requesting academic accommodations based on a disability is required to register
with Disability Services and Programs (DSP) each semester. A letter of verification for approved
accommodations can be obtained from DSP. Please be sure the letter is delivered to me and to
the TA as early in the semester as possible. DSP is in STU 301 and is open 8:30 a.m.-5:00 p.m.,
Monday through Wednesday. Website and contact information for DSP:
http://sait.usc.edu/academicsupport/centerprograms/dsp/home_index.html; Phone: (213) 740-
0776; TDD Only: (213) 740-6948; Fax: (213) 740-8216; email: ability@usc.edu.

Course Notes
1) Late Assignments: Assignments turned in late will receive a 5% reduction each day for
the first two days turned in late. For the following five days (i.e., after the first two
days) the late assignment will result in a 10% reduction for each day it is late. After
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2)

3)

4)

5)

6)

seven days, an assignment cannot be turned in and will result in a grade of zero.
Students who experience medical emergencies that prevent them from attending class
on days when class exercises or assignments are scheduled need to notify me as soon as
possible so arrangements can be made. USC athletes should meet with me as soon as
possible regarding their scheduled athletic events that may conflict with course
requirements.

Email: | typically respond to emails within 24 hours or less. However, | rarely respond
to emails between 5:00 p.m. on Friday to 8:00 a.m. on Monday (i.e., the weekend). |
will do my best to email over the weekend if it is urgent, but please note that | cannot
guarantee it.

Feedback: Your lab instructor and I will make every attempt to return assignments in a
reasonable time by returning them no later than two weeks after the due date.

Appeal Process: If you find that your answer in an assignment or exam was incorrect,
but you think it is correct, you can appeal the decision in writing. The written appeal
must have supporting documentation (e.g., reference to a class reading). The appeal
cannot be based on your opinion or personal experience, but rather based on the course
materials. Appeals must be delivered to the instructor no later than one week after the
grade is posted. Appeals will not be accepted via email and no late appeals will be
accepted.

Course Participation: Your best bet at remembering and understanding the material is
to complete the required readings BEFORE class. Also, keep in mind that you may
need to do multiple readings of the textbook to gain a full comprehension.

University Escort Service: If you feel that you would like to be escorted to your vehicle,
bus, or campus residence after 5:00 p.m., do not hesitate to call (213) 740-4911.

Special Notes

1)

2)

3)

4)

5)

This course is more based on applied learning and less on memorization. There are no
exams, midterm, or final exam. You will, however, need to dedicate the time that you
would typically spend studying for tests to conducting your research. As in any course,
work of a significantly high caliber in each of the components of this course is an A
(i.e., exceptional work). It is especially important that you be on time for class, have
completed your reading assignments prior to class-time, and that you are prepared for
discussion of these materials in class.

All assignments in this course are expected to be word-processed and graphs/tables
should be computer-generated.

All assignments should be completed using APA-style, including the use of a title
page. Assignments are due on predetermined due dates and should be submitted
electronically through Bb. Word processing and data management software are
available in several computer labs on campus. You should consult your APA
Publication Manual for all writing assignments.

All students are expected to have access to the student computer network. It is your
responsibility to ensure that your access is up to date during the semester.

Tutors are available through the Learning Resource Center (LRC). If you should find
that you are not doing as well in this course as you would like, please see your lab
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instructor or me immediately. We will help you: It is our job! You can also arrange
short-term or long-term tutoring through the LRC. The Writing Center is also available
to tutor students who are having difficulty with writing. For assistance, visit their
website at http://college.usc.edu/writingcenter/ or call (213) 740-3691.

Emergency Preparedness/Course Continuity in a Crisis

In case of a declared emergency if travel to campus is not feasible, USC executive leadership
will announce an electronic way for instructors to teach students in their residence halls or homes
using a combination of Blackboard, teleconferencing, and other technologies.

Statement of Course Content as a Copyright

It is important to know that all material presented in class, labs, or discussion sent via email or
posted on Blackboard is “all rights reserved” by the course instructor. In addition, some of it is
copyrighted and distributed by a publishing corporation for in-class use only. You may not store,
post, or distribute any course materials—on paper or electronically--for use by any student not
presently enrolled in this course. Out of fairness to all current and future students, please do
your part to protect our course content.

Syllabus as a Contract

The purpose of this syllabus is to provide a contract between the instructor and the student. By
enrolling in this class, you agree that you have read, understand, and will adhere to the syllabus
guidelines and complete the assignments given in the class. | reserve the right to change the
schedule of topics and readings and I will give notice to you of such changes well in advance of
those changes.

The Foundation to Understanding Statistics!
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Figure 1. Visual representation of a small effect size (left side) vs. a large effect size (right side).
Note the difference between the two distributions in each visual and how the power of an
experiment changes based on the size of the treatment effect.
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